
A good PowerPoint presentation will 
meet your audience�s demands � not 
your own. With a topic dropdown menu, 
you can give your audience a choice of 
what you�ll cover and in what order.

Many companies rely on the Internet 
or other insecure paths to communicate 
between two computers or networks. 
With a VPN (virtual private network), 
you can communicate without taking 
unnecessary security risks.

Web development should increase 
the user�s experience. Make sure that 
when your user needs to select a choice 
from a dropdown list, he can type the 
�rst few letters and e�ectively narrow 
down his choices.

Putting your training into practice.
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From the Editor

Let your audience guide your PowerPoint 
presentation with a cool dropdown menu

Whether you�re giving a sales presentation or leading a discussion, your audience may have 
their own ideas about what they need you to cover and when. You can add a welcome �exibility 
to your presentation by navigating with a topic menu. The audience sees what topics are 
available and guides the presentation by telling you which topic to cover next. You just select a 
topic from the menu to go to slides that cover the desired topic.

Another great situation for a menu is a 
presentation with no presenter. For example, 
you may put a presentation on a computer in 
the Human Resources department or on the 
company�s Intranet, and employees navigate 
themselves through that presentation to 
read about topics relevant to them. 

Build a presentation 
covering several topics
Start by creating your presentation and 
dividing it up into several topics. Each topic 
can have as many slides as you want, but you 
can also create one slide containing the entire 
topic, as shown in Figure A. It all depends on 
how much content the topic needs.

Complete the presentation before 
you create the menu, because you�ll need 
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to link the menu items to the appropriate 
slides.

Create the 
dropdown menu
Add a new slide before the �rst 
slide. This slide will contain the 
dropdown menu.

To create the menu objects:

1.		  Insert an AutoShape of the 
desired shape and size. 
We went to the Drawing 
toolbar and chose 
AutoShapes | Basic Shapes 
| Rounded Rectangle. (In 
PowerPoint 2007, go to 
the Home tab | Drawing 

group | Shapes, and choose the 
desired shape.)

This slide explains the vacation policy for employees.A 	

http://www.newhorizons.com/content/coursecatalog.aspx?keyword=PowerPoint%202007%20
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3.		  In the Wipe dialog box, click the 
Triggers button, and then select 
the Start E�ect On Click Of option 
button.

4.		  From the dropdown list to the 
right, choose your Main Menu 
object, as shown in Figure C.

5.		  Click OK.
We want the submenu buttons to 
disappear so that the next time we show 
the dropdown menu�s slide, only the 
Main Menu button appears. This way, 
we can click the Main Menu button 
each time to wipe down the submenu 
buttons. 

To make the submenu buttons 
disappear, select them and choose Add 
E�ect | Exit | Disappear in the Custom 
Animation task pane. If the new anima-
tion isn�t above the trigger, drag it up. 

In the Start box, choose With Previous 
from the dropdown list.

Solve the replay problem
If you create links on the other slides 
to go back to this slide, the submenu 
disappears the �rst time, but when 
you try again, the Disappear animation 
doesn�t work any more! That�s because 
PowerPoint disables certain features 
when a slide is displayed more than once. 

To make the submenu disappear 
each time you display it:

1.		  Click the Main Menu slide in the 
left Slides pane and press [Ctrl]D to 
duplicate that slide. 

2.		  Select the �rst of the two identical 
slides. On that �rst slide, delete the 
submenu so that only the Main 
Menu button remains, as shown in 
Figure D. 

2.		  With the AutoShape (or Shape) still 
selected, add some text, such as 
Main Menu.

3.		  Just below the Main Menu, add 
AutoShapes for the topics in your 
presentation. Add text for each 
topic, as shown in Figure B. You�ll 
turn these into clickable buttons.

Add animation to the 
dropdown menu
We want the submenu buttons to slide 
down when we click the Main Menu 
button. To accomplish this, we�ll use the 
Wipe e�ect, but you can choose another 
e�ect if you like. The Peek e�ect is 
another good option.

To add the Wipe e�ect:

1.		  So that the submenu items slide 
down all at once, select all of the 
submenu objects and group them 
by going to the Drawing toolbar 
and choosing Draw | Group. (In 
PowerPoint 2007, press [Ctrl]G.)

2.		  Choose Slide Show | Custom 
Animation. (In PowerPoint 2007, go 

to the Animations tab | Animations 
group | Custom Animation.)

3.		  With the submenu buttons 
selected, choose Add E�ect | 
Entrance | Wipe in the Custom 
Animation task pane. (If you don�t 
see the Wipe animation, click More 
E�ects from the list of entrance 
e�ects.)

4.		  Set the direction to From Top and 
the speed to Very Fast.

You want the menu to wipe down when 
you click the Main Menu. To do this, you 
use the trigger feature. 

To add a trigger for the submenu:

1.		  Select the submenu�s animation 
item in the Custom Animation task 
pane.

2.		  Open the dropdown list to the 
right and choose Timing.

B 	
These AutoShapes 
are the basis for 
your dropdown 
menu.

C 	
A trigger is a button that 
starts animation when 
you click it.

http://www.newhorizons.com/Win7Career?utm_source=elevate&utm_medium=email&utm_campaign=windows-7-free-software


3
February 2010New Horizons Computer Learning Centers, Inc.

3.		  With that �rst slide still selected, 
choose Slide Show | Slide 
Transition from the menu bar. (In 
2007, choose the Animations tab.) 
Deselect the On Mouse Click check 
box and select the Automatically 
After check box, which should say 
00:00, as shown in Figure E.

You�ll link to the �rst of the two (almost) 
identical slides, but because of the slide 
timing, the audience will see only the 

second slide. This tricks PowerPoint into 
letting the animation function every 
time.

Add hyperlinks
The entire menu functions using 
hyperlinks. You�ll hyperlink to the �rst 
slide of each topic. Then you�ll add 
hyperlinks back to the �rst of the two 
Main Menu slides.

To add hyperlinks to the topic slides:

1.		  On the second Main Menu slide, 
click the topmost of the submenu 
AutoShapes. Because you grouped 
the submenus, PowerPoint selects 
all of the AutoShapes. Now click on 
the edge of the top submenu item 
to select it. 

2.		  Choose Insert | Hyperlink from the 
menu bar. (In 2007, go to the Insert 
tab | Links group | Hyperlink.)

3.		  In the Insert Hyperlink dialog 
box, click Place In This Document 
button on the left and choose the 
slide that the topmost submenu 
should link to. 

4.		  Repeat steps 1-3 for the other 
submenu AutoShapes. 

During the presentation, you�ll use the 
Main Menu slide to jump to your topics, 
but when you�re �nished discussing that 
topic, you need a way to get back to the 
Main Menu.

To link back to the Main Menu slide:

1.		  Display the �rst slide that your �rst 
submenu button links to � that is, 
your �rst topic�s slide.

2.		  Add an AutoShape to the slide. We 
chose the Home action button. 
(If you use an action button, the 
Action Settings dialog box opens; 
click Cancel to close it.) Format and 
place the button as you wish.

3.		  Press [Ctrl]K. If you used an action 
button, the Action Settings dialog 
box opens. Choose the Hyperlink 
To option button select First Slide 
from the corresponding dropdown 
list, and click OK. Otherwise, in 
the Insert Hyperlink dialog box, 
click the Place In This Document 
button on the left and choose 
First Slide. This ensures that the 
Disappear animation always works. 
No one will notice that you�re 
going to a �dummy� �rst slide 
because the slide timing moves 
you immediately to the next slide 
� which is your real menu slide. 

4.		  Copy your hyperlinked button 
onto the other slides that you�re 
linking to. These buttons get you 
back to the Main Menu slide. 

Test your menu
It�s a good idea to test your menu to 
make sure that the hyperlinks all work in 
Slide Show view and that the menu slides 
down and disappears properly. If you 
�nd a problem, recheck the animation 
and hyperlink settings.

Business skills for the new world of work
In business today, productivity is key to your success. Whether that means setting up 
projects for success, forecasting and analyzing trends, or managing critical business 
information, it is vital that you have the skills to work at peak performance. You already 
know how to use Microsoftfi O�ce System applications. New Horizons o�ers Microsoft 
Business Skills Series Courses to teach you how to use those applications to more e�-
ciently manage, work with, and prioritize information to make better decisions. Go to 
www.NewHorizons.com for information on courses that cover topics such as:

	4004 Managing Critical Business Information Using Microsoft O�ce Access 2003
 4005 Beyond the Spreadsheet: Managing Financial Information Using Microsoft 
O�ce  
Access 2003

	4007 Creating E�ective Presentations Using Microsoft O�ce PowerPoint 2003 

The �rst slide is a �dummy� slide and lets PowerPoint play 
the animation repeatedly.D 	

When you hyperlink to the �rst 
slide, PowerPoint immediately 
advances to the second slide.

E 	

http://www.newhorizons.com


4
February 2010New Horizons Computer Learning Centers, Inc.

Windows support
Windows 2000 Server and Windows 
Server 2003 support PPTP and L2TP VPN 
protocols. Both operating systems can 
also use IPSec in tunnel mode, although 
Microsoft recommends this primarily 
for cases where the other end of the 
connection doesn�t support PPTP or L2TP. 

Each VPN technology has advan-
tages and disadvantages. Let�s look a 
little more closely at each.

PPTP
PPTP was developed by Microsoft. It�s 
based on the Point-to-Point Protocol 
(PPP) and uses the same authentication 
methods. Its level of security depends 
in part on which authentication method 
you choose, as described here:

�		  Microsoft Challenge-Handshake 
Authentication Protocol (MS-
CHAP) v.2. Combined with a 

Choose the VPN solution that best meets 
your business requirements

Employees, business partners, customers, and others may need to access the resources on your company�s 
intranet. They could dial in to a remote access server, but it�s often more convenient and more cost-e�ective 
to use the internet. Unfortunately, the internet is a public non-secure network and as such can present a 
substantial risk to the communications that occur between parties.

Virtual private networks solve this problem 
by creating a secure tunnel between the 
endpoints of a communication channel. 
Security is implemented via authentication 
(requiring entities to prove their identity), 
encryption (masking real data as cipher 
text), or some combination thereof.

Types of VPNs
There are several ways to categorize 
VPNs. We�ll look �rst at the two types of 
VPN connections. Then, we�ll discuss the 
popular VPN technologies supported 
by Windows 2000 Server and Windows 
Server 2003.VPNs can connect in two 
ways � Remote Access VPN and Site-to-
Site VPN. Here are their di�erences:

�		  Remote Access VPN. A single 
computer establishes a connection 
to a VPN server. The server can also 
act as a VPN gateway, providing 
access to other computers on the 
internal network.

�		  Site-to-Site VPN. Gateways at both 
ends of the connection establish 
a virtual private link between two 
LANs, allowing the computers on 
one LAN to communicate with 
those on the remote LAN.

VPN protocols
The three most popular VPN protocols in 
use today are:

�		  PPTP. Uses the Point-to-Point 
Tunneling Protocol (PPTP) and 
the Microsoft Point-to-Point 
Encryption Protocol (MPPE).

�		  L2TP. Uses the Layer 2 Tunneling 
Protocol (L2TP) and Internet 
Protocol Security (IPSec) for 
encryption.

�		  IPSec Tunneling Mode. Uses 
IPSec both to establish the tunnel 
and to provide encryption.

Related Courses
�	  	 Security +

�	  	 6421 Con�guring and Troubleshooting a Windows 
Server 2008 Network Infrastructure

strong password policy, MS-CHAP 
provides good PPTP security. 

�		  Extensible Authentication 
Protocol-Transport Level 
Security (EAP-TLS). With 
certi�cate-based smart card 
authentication, EAP-TLS provides 
even more security. This 

I N F O R m A T I O N  S Y S T E m S  P R O T E C T I O N

http://www.newhorizons.com/content/coursecatalog.aspx?keyword=Security%2B
http://www.newhorizons.com/content/coursecatalog.aspx?keyword=6421%20Configuring%20and%20Troubleshooting%20a%20Windows%20Server%202008%20Network%20Infrastructure
http://www.newhorizons.com/content/coursecatalog.aspx?keyword=6421%20Configuring%20and%20Troubleshooting%20a%20Windows%20Server%202008%20Network%20Infrastructure
http://www.newhorizons.com/content/pressReleases.aspx?id=2264&sub=3&did=125&more=1
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method requires a Public Key 
Infrastructure (PKI), so there�s more 
administrative overhead involved.

PPTP uses MPPE to encrypt VPN tra�c. 
MPPE provides for data con�dentiality 
using the RC4 algorithm. The encryption 
keys are 40 or 128 bit and are generated 
by the MS-CHAP, MS-CHAP v.2, or EAP-TLS 
authentication method. 

PPTP is compatible with many 
di�erent systems, making it a popular 
choice in cross-platform environments. 
When determining if PPTP is right for 
you, consider the following:

�		  You can use PPTP with client 
computers that are behind a 
Network Address Translation (NAT) 
device using a PPTP editor.

�		  PPTP works well for point-to-point 
connections, but wasn�t designed 
for site-to-site connections. 

�		  We recommend PPTP for 
organizations that need a 
medium level of security, easy 
implementation, and a high level 
of interoperability.

L2TP
The Layer 2 Tunneling Protocol was 
developed by Microsoft and Cisco. It 
combines elements of PPTP and Layer 
2 Forwarding (L2F) protocol. L2TP was 
designed to be more secure than PPTP 
because it uses both certi�cate-based and 
PPP authentication. 

L2TP uses IPSec to encrypt the 
VPN tra�c. IPSec encryption provides 
data con�dentiality like MPPE, but it 
goes further, providing the following 
security mechanisms for each packet:

�		  Data integrity. Assurance that data 
hasn�t been modi�ed in transit.

�		  Data origin authentication. 
Veri�cation that the data really 
came from the sender.

�		  Replay protection. Prevents 
a hacker from capturing a 
transmission and replaying it to 
gain access.

L2TP provides a high degree of support 
on di�erent platforms, such as Windows 
2000, XP, and Server 2003, 9x, Me, and NT, 
Macintosh OS X v. 10.3 (Panther), and Linux.

L2TP/IPSec supports mutual 
authentication of both client and 
server. You can con�gure IPSec to use 
pre-shared keys, which you enter man-
ually on each computer. You should 
do this only if a PKI isn�t available. The 
better security practice is to use digital 
certi�cates for authentication. 

L2TP encapsulates the original 
packet in a PPP frame, and then encap-
sulates the PPP frame inside a UDP 
message. The original packet (the PPP 
payload), the PPP header, the L2TP 
header, and the UDP header are all 
encrypted by IPSec�s Encapsulating 
Security Payload (ESP) protocol. If you 
decide to implement L2TP, keep in 
mind the following:

�		  L2TP supports multiple networking 
protocols. You can use it to 
encapsulate IPX/SPX tra�c along 
with TCP/IP tra�c.  

�		  Initially Windows 2000 L2TP/IPSec 
wasn�t compatible with NAT, but a 
NAT Traversal (NAT-T) update, which 
works with IPSec, is available for 
Windows 2000 with SP3 or above. 

�		  Current versions of L2TP/IPSec in 
Windows XP/2003 support (NAT-T). 

�		  You can use L2TP for both remote 
access and site-to-site VPN.

IPSec tunnel mode
To provide an extra layer of encryption, 
you can use IPSec with another tunneling 
protocol, such as L2TP. You can also use 
it alone, creating the tunnel connection 
and encrypting the tunneled tra�c. 
IPSec operates in two discrete modes:

�		  Transport mode. IPSec encrypts 
data as it travels between two 
endpoints. This mode doesn�t wrap 
protocols within one another. 

�		  Tunnel mode. Packets are 
encapsulated at the gateway and 
decapsulated at the other gateway. 
Tunnel mode is used primarily for 
site-to-site VPNs. 

IPSec only works with TCP/IP tra�c. If 
other network protocols are involved, 
L2TP is the correct choice.

The advantage of using IPSec to 
create the tunnel is that it provides 

interoperability between a Windows 
2000/2003 VPN server/gateway and 
a third-party gateway on the other 
end of the connection that doesn�t 
support PPTP or L2TP. This is usually 
a third-party �rewall or dedicated 
VPN appliance. IPSec actually consists 
of the following primary protocols: 
Authentication Header (AH) and 
Encapsulating Security Payload (ESP).

Authentication Header (AH)
In tunnel mode, AH encapsulates the 
original IP packet and its header with an 
AH header and another IP header. AH 
signs the packet to provide data integrity, 
but doesn�t provide con�dentiality.

Encapsulating Security 
Payload (ESP)
ESP in tunnel mode encapsulates the 
original IP packet and its header with 
an ESP header and another IP header, 
similarly to AH. It also adds an ESP 
authentication trailer. ESP encrypts 
the original IP packet and its header 
to provide data con�dentiality. The 
authentication trailer signs the encrypted 
IP packet and header and the ESP header, 
but not the new IP header.

When the encapsulated and 
encrypted packet gets to the remote 
gateway, the packet is decrypted. The 
gateway uses the original IP header to 
get the packet to the correct computer 
on its network.
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ing elapsed time to cause the code to 
reset itself, and using an object param-
eter to achieve greater code modular-

Boost user productivity with smarter 
dropdown list searches

Sometimes clients may expect more functionality than standard HTML controls provide. For instance, 
when you create a dropdown list using a <select> tag and corresponding <option> items, you don�t get the 
functionality of familiar dropdown lists in desktop applications. The World Wide Web Consortium standards 
only provide for dropdown lists with limited search functionality, as shown in the upper-right window of 
Figure A. In the example, when a user types ark, a standard dropdown list selects the �rst item beginning with 
K, but a dropdown list with incremental search functionality �nds the �rst item beginning with ark.

In the standard dropdown list a user�s key 
press event causes the control to select 
the �rst item beginning with the character 
pressed. Pressing the same key again 
selects the next item beginning with that 
character; pressing a di�erent key selects 
the �rst item that starts with the new 
character. This behavior can frustrate users 
who want to use as few keystrokes and 
mouse movements as possible.  

To satisfy your clients and save 
users from frustration, you may want 
your dropdown lists to function more 
like a standard desktop application, as 
shown in the lower-left portion of Figure 
A. While developers often purchase 
third-party controls to meet this require-
ment, you can increase your control over 
the end result and save yourself the cost 
of purchasing scripts by using the simple 
JavaScript function we�ll demonstrate 

for you and gaining an understanding of 
each of its components.

Improve the user�s search 
experience
We�ll show you how to add advanced, 
incremental searches to your dropdown 
lists, using only client-side code. With this 
functionality in place, when a user types 
several characters in succession (a, r, k, for 
example), the dropdown list will select 
the �rst item that begins with a string 
consisting of all characters the user has 
pressed (ark, in this example). 

In the process, we�ll provide you 
with the necessary JavaScript code to 
programmatically select an item in a 
dropdown list, and to build a string 
from successive key press events. We�ll 
also highlight some key supporting 
techniques code � such as determin-

Related Courses
�	 	 HTML 4.01: Web Authoring - Level 1

�	 	 HTML 4.01: Web Authoring - Level 2

�	 	 HTML 4.01: Web Authoring - Level 3
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ity. Throughout, we�ll show you how to 
properly integrate the code into your 
web pages.

A
An incremental search  
makes your dropdown list 
more user-friendly.

http://www.newhorizons.com/content/coursecatalog.aspx?keyword=HTML+4.01%3a+Web+Authoring+-+Level+1
http://www.newhorizons.com/content/coursecatalog.aspx?keyword=HTML+4.01%3a+Web+Authoring+-+Level+2
http://www.newhorizons.com/content/coursecatalog.aspx?keyword=HTML+4.01%3a+Web+Authoring+-+Level+3
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Note: Be careful when changing the 
behavior of a control from what users 
typically expect. You may want to add 
simple instructions. The decision to 
customize control behavior is easier for 
intranet application, where you�re coding 
to speci�c requirements and users can 
receive appropriate training.

Insert the JavaScript
The JavaScript in Listing A adds 
incremental search functionality to any 
dropdown list. This code captures the 
user�s onKeyPress events to build a search 
string. If a user presses successive keys 
(a then r then k, for example) with less 
than three seconds between successful 
presses, the IncrementalSearch() function 
combines the characters and searches the 
dropdown list for the �rst item beginning 
with the new search string (ark, in this 
example). To add this code to your page, 

simply type the Listing A code inside a 
<script> element in the <head> section of 
your HTML page.

Determine elapsed time 
to force a reset
When incorporating the JavaScript 
code from Listing A into your web 
projects, pay careful attention to 
the variable declarations above 
the IncrementalSearch() function 
declaration. It�s important to declare 
these variables outside the function so 
the browser remembers their values 
between events. If you leave out these 
variables when copying and pasting � 
or try to declare them inside the function 
itself � you�re not going to get Arkansas, 
Kansas, or anywhere else.

We�ll use the �rst of these vari-
ables, keys, to store the string of char-
acters the user has typed. The other 
variable, tSave, is perhaps a little more 

interesting. When the page loads, tSave 
contains the current date and time, 
just because we made it a Date() object 
with the = new Date() syntax. We�ll keep 
updating this variable with that same 
syntax, and use it to determine how 
much time has elapsed between key-
strokes. If the user pauses a long time, 
or enters keystrokes for a long time 
without seeing any change in the drop-
down list, we�ll assume he either wants 
to start over, or has typed a word that�s 

not going to match anything no matter 
how hard he tries. You�ll see how this 
works by following all references to the 
variables tSave, now, and lagTime.

Pass an object parameter 
for maximum flexibility
Another thing you should pay close 
attention to is the oSelect parameter 
we pass to the IncrementalSearch() 
function. We chose that name by 
abbreviating object as o and <select> as 

Graphic & Design eTips to Enhance 
Your Work
If you are an expert at what you do, then you 
want to sign up for FREE New Horizons Graphics & 
Digital Designer eTips. Each week you will receive 
expert advice from our experienced editors that 
will improve your productivity and enhance your 
work. Learn more about the applications you use 
everyday, including: Adobe Illustrator, Adobe 
InDesign, Adobe Pagemaker, Adobe Photoshop, 
Digital Photography and QuarkXPress. Imagine 
the possibilities with the skills you�ll gain!  

var keys;

var tSave = new Date();

function IncrementalSearch(oSelect) {

	 var now;

	 var lagTime;

	 var i;

	 var item;

	 var key = event.keyCode;

	 event.returnValue=false;

	 if ((key>=97 && key<=122) ||

	 (key>=65 && key<=90) || (key>=48 && 

key<=57)) {

		  key = String.fromCharCode(key);

		  now = new Date();

		  lagTime = (now.getTime() - tSave.

getTime());   

		  if (lagTime > 3000 || !keys) {

			   keys = key;

			   keys = keys.toLowerCase()

      } else {

			   keys = keys + key;

			   keys = keys.toLowerCase()

		  }

		  for (i=0;i<oSelect.children.

length;i++) {

			   item = oSelect.children[i].text;

			   if (item.substring(0,keys.

length).

			   toLowerCase()==keys) {

				    if (oSelect.selectedIndex != i) 

{

					     tSave = new Date();

				    }

				    oSelect.selectedIndex = i;

				    break;

			   }

		  }

	 }

}

Listing A:
Code to capture onKeyPress events and incrementally search a dropdown list

http://www.newhorizonsetips.com
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